
D at a w at c h  M o n ar c h  R el e a s e  N ot e s           V er si o n  1 5. 3. 0

D e c e m b er  1 1,  2 0 1 8

I S S U E I D R E S O L V E D I S S U E
M O N A R C H  C L A S SI C ( M O N A R C H  C L A S SI C  &  M O N A R C H  C O M P L E T E)

M O D - 3 2 7 3 I n c orr e ct  pr o d u ct  n a m e  u s e d f or  P a n o pti c o n  D e si g n er (f or m erl y  D at a w at c h  D e si g n er)

M O D - 3 3 3 6 M o n ar c h  Utilit y fr e e z e s  w h e n  T e st  C o n n e cti o n f or  M o n ar c h  S w ar m i s  cli c k e d  m ulti pl e ti m e s

M O D - 3 3 5 6 C h a n gi n g  a n  E xt er n al  L o o k u p  D at a  S o ur c e  wit h  a  c orr u pt  M o d el  m a y  c a u s e  a  cr a s h

M O D - 3 3 8 7 M o n ar c h r e a d s  e m pt y  v al u e s i n  a r e p ort  a s  n ull

M O D - 3 3 9 1 S e q u e n c e  of  o p er ati o n s f or  d efi ni n g  E x a ct  M at c h  k e y  c a n r e s ult i n  a n i n c orr e ct  s u m m ar y.

M O D - 3 3 9 4 C o p y fr o m  R e p ort  Vi e w  d o e s  n ot r et ai n r e p ort  ali g n m e nt  w h e n  p a st e d

M O D - 3 3 9 5 D ef a ult  E xt er n al  M o d el s  a n d  S etti n g s  N ot  S a v e d  T o  R e gi str y

M O D - 3 3 9 9 Err or i n  d o c u m e nt ati o n f or  Citri x i n st all

M O D - 3 4 0 0 Cr a s h  o n  s u m m ar y  w h e n i n v o ki n g t h e  c o nt e xt  m e n u  a n d  a n i n c orr e ct  n u m b er  of  m e a s ur e s  h a s  b e e n  st or e d i n t h e  m o d el

M O D - 3 4 0 3 E x c el  err or  w h e n  o p e ni n g  a n  e x p ort e d  E x c el fil e: " R e m o v e d  P art: / xl/ s h ar e d Stri n g s. x ml  p art  wit h  X M L  err or. ( Stri n g s) Ill e g al  x ml  c h ar a ct er "

M O D - 3 4 0 6 C o n v er si o n fr o m t e xt t o  d at e f ail s  w h e n  u si n g  c o m m a  a s  d e ci m al  s e p ar at or f or fr a cti o n al  s e c o n d s

M O D - 3 4 1 1 M o d el  cr e at e d fr o m  pr e vi o u s  v er si o n i s  n ot  gi vi n g t h e  e x p e ct e d  o ut p ut

M O D - 3 4 1 2 I n v o ki n g ' Fi n d i n  T a bl e' fr o m  s u m m ar y  vi e w  w h e n  s e ar c h i s  a cti v e i n t a bl e  vi e w  m a y  c a u s e  a  cr a s h

M O D - 3 4 1 8 M o d el i nf or m ati o n i s i n  Fr e n c h  w h e n  o p e n e d i n  M o n ar c h  E n gli s h  v er si o n  a n d t h e  O S  di s pl a y l a n g u a g e i s  n eit h er  E n gli s h  n or  Fr e n c h

E N H A N C E M E N T M o n ar c h i n st all er  s wit c h  a d d e d t o  s p e cif y  c u st o m  S Q L  S er v er  L o c al D B  v er si o n t o  u s e  a s t h e  c a c h e

D A T A  P R E P  S T U DI O ( M O N A R C H  C O M P L E T E  O N L Y)

D P S - 1 9 9 0 N o  P a s s w or d  Di al o g  pr o m pt  w h e n  o p e ni n g  a  Pr oj e ct  wit h o ut  a  s a v e d  p a s s w or d

D P S - 2 2 0 7 Err or  o c c ur s  aft er  a  S e s si o n  Ti m e o ut  w h e n  u si n g  S w ar m

D P S - 3 1 9 8  /  D P S - 3 3 3 2 N ull s  a p p e ari n g  w h e n  u si n g  d at a fr o m  a  S w ar m  Li br ar y

D P S - 3 1 9 9 L o n g  d el a y  b ef or e t h e  a p pli c ati o n  b e c o m e s r e s p o n si v e  aft er t e sti n g  a f aili n g  S w ar m  c o n n e cti o n 

D P S - 3 3 2 2 S w ar m  c a n n ot r e n d er  C urr e n c y f or m at i n  a n  u pl o a d e d  w or k s p a c e

D P S - 3 8 7 1 S w ar m  o nl y r et ai n s  o n e  m o d el fr o m  a n  u pl o a d e d  w or k s p a c e  wit h  m ulti pl e r e p ort i n p ut/ m o d el  p air s
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D at a w at c h  M o n ar c h  R el e a s e  N ot e s           V er si o n  1 5. 3. 0

D e c e m b er  1 1,  2 0 1 8

I S S U E I D R E S O L V E D I S S U E
D P S - 4 3 2 8 " S ort  Pi v ot  C ol u m n s"  o pti o n  of  a  Pi v ot tr a n sf or m  n ot  s el e ct e d i n  S w ar m  aft er  u pl o a di n g  a  w or k s p a c e

D P S - 4 3 5 1 U n e x p e ct e d  Err or  w h e n  cli c ki n g " Br o w s e fr o m  S w ar m f ol d er "

D P S - 4 3 8 2 U n e x p e ct e d  Err or  w h e n  cli c ki n g " Br o w s e fr o m  S w ar m  p at h" f or r e p ort s

D P S - 4 3 8 4 Err or:  P u bli s h t o  M o n ar c h  S w ar m f ail e d.  O bj e ct r ef er e n c e  n ot  s et t o  a n  o bj e ct -  U s e  S w ar m  S o ur c e

D P S - 4 4 0 2 Pr e vi e w  D at a  b utt o n i s  e n a bl e d  e v e n  wit h  n o  d efi n e d  q u er y i n  S pl u n k

D P S - 4 4 1 8 A cti o n  s etti n g  n ot  s a v e d  w h e n  e diti n g  a filt er 

D P S - 4 4 6 5 S w ar m f ail s  w h e n  u pl o a di n g  a  w or k s p a c e  w hi c h  c o nt ai n s t a bl e s t h at r ef er e n c e  diff er e nt  s h e et s fr o m t h e  s a m e  E x c el fil e

D P S - 4 4 9 7 G o o gl e  S h e et s  UI  n ot  si z a bl e

D P S - 4 5 0 1 U n a bl e t o l o a d  S w ar m  Li br ar y  u si n g  d ef a ult  a d mi n  u s er

D P S - 4 5 0 6 R e c e nt it e m s f or  p df fil e s i n t h e  o p e n  d at a  di al o g  n ot f u n cti o ni n g

D P S - 4 5 1 6 N ot tr a p i n di c at or s  ar e  p ai nti n g i n t h e i n c orr e ct l o c ati o n

D P S - 4 5 3 1 S w ar m  u n a bl e t o  a c c e pt  a n  u pl o a d e d  w or k s p a c e  w hi c h  c o nt ai n s  a  d at e filt er

D P S - 4 5 3 9 R e g e x  d o e s n't  s h o w  di s a bl e d li n e s  aft er  a c c e pti n g  e x pr e s si o n

D P S - 4 5 5 2 C ol u m n s  cr e at e d  b y fl a g  d u pli c at e s  o pti o n  of  D u pli c at e s tr a n sf or m  c a n n ot  b e  u s e d  a s  k e y s i n  a  D u pli c at e s tr a n sf or m

D P S - 4 5 5 3 I n c orr e ct  d at e f or m at  w h e n  s a vi n g  a  w or k s p a c e t o  S w ar m  u si n g  C S V i n o ut  c o nt ai ni n g  Ti m e f or m at

D P S - 4 5 6 4 T e m p or ar y fil e s  wit h  s e g m e nt *  pr efi x  ar e  n ot  d el et e d  w h e n  cl o si n g t h e  a p pli c ati o n

D P S - 4 6 0 0 C o n v er si o n fr o m t e xt t o  d at e f ail s  w h e n  u si n g  c o m m a  a s  d e ci m al  s e p ar at or  wit h  a  D at e Ti m e  c o nt ai ni n g fr a cti o n al  s e c o n d s

D P S - 4 6 1 2 S p uri o u s  err or  m e s s a g e  w h e n  n o  S w ar m  S er v er i s  c o nfi g ur e d

D P S - 4 6 1 7 M o d el  c r e a t e d f r o m  pr e vi o u s  v e r si o n i s  n ot  gi vi n g t h e  e x p e ct e d  o ut p ut

N E W  F E A T U R E S p ar k  S Q L,  Cl o u d er a  C D H  a n d  A cti v e  Dir e ct or y  C o n n e ct or s  a d d e d

E N H A N C E M E N T Filt er  e n h a n c e m e nt s

E N H A N C E M E N T S w ar m  2. 2  c o m p ati bilit y

E N H A N C E M E N T G o o gl e  S h e et s  C o n n e ct or  UI  e n h a n c e m e nt s
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D at a w at c h  M o n ar c h  R el e a s e  N ot e s           V er si o n  1 5. 3. 0

D e c e m b er  1 1,  2 0 1 8

I S S U E I D R E S O L V E D I S S U E

LI C E N SI N G ( M O N A R C H  C L A S SI C  &  M O N A R C H  C O M P L E T E)

L A - 2 8 6 C o nf u si n g  Li c e n s e  M a n a g er  C o n n e cti o n  o pti o n s 

L A - 3 1 8 C h o o s e  Li c e n s e  M et h o d  s cr e e n: [ B a c k]  b utt o n i s n't  di s pl a y e d  aft er  d e a cti v ati o n.

L A - 3 4 0 C o p y  M a c hi n e  D o m ai n  N a m e  n ot  w or ki n g

L A - 3 4 3 L M  c o ul d  n ot  s e n d  U s er  R e gi str ati o n  D at a t o  P ar d ot  s er v er

L A - 3 4 4 A d d  p o s si bilit y t o  c o nfi g ur e  all o w e d  s e c ur e  pr ot o c ol s ( wit h  UI)

L A - 3 4 5 Sil e nt  a cti v ati o n  a n d  s y n c hr o ni z ati o n  d o e s n't  w or k f or  M o n ar c h  1 5  S u b s cri pti o n  pr o d u ct

L A - 3 4 8 ' Pr o x y'  a n d ' D a e m o n Pr o x y'  u s er  p a s s w or d s i n li c e n s e  c o nfi g fil e  w er e  n ot  e n cr y pt e d

E N H A N C E M E N T A ut o m ati c  pr o x y  d et e cti o n f or li c e n si n g  vi a  a cti v ati o n

E N H A N C E M E N T A bilit y t o  c o nfi g ur e  all o w e d  s e c ur e  pr ot o c ol s ( S S L  3. 0 /  T L S  1. 0 /  T L S  1. 1 /  T L S  1. 2 )

E N H A N C E M E N T A bilit y t o  o bt ai n  M a c hi n e  N a m e
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Datawatch Monarch Release Notes           Version 15.2.0
October 1, 2018

ISSUE ID RESOLVED ISSUE
MONARCH CLASSIC (MONARCH CLASSIC & MONARCH COMPLETE)

MOD-3089 Increase Character field length to 255 so Varchar(255) is deemed a character field for V11 compatibility

MOD-3197 Cannot delete an invalid external lookup.

MOD-3204 PDF files do not open in open dialog grid sort order when using multiple selectiion

MOD-3207 Illegal Name syntax error message when trying to export to existing excel worksheet is unhelpful

MOD-3223 SdkDocInfo.ToIso8601DateTime Exception when opening PDF file created by Monarch

MOD-3237 Cannot open text files as a database (or external lookup) if blank rows exist at the start of the file

MOD-3241 Certain Negative signs are not recognized in PDF files

MOD-3297 Crash when loading a 3.4GB text report and model file

MOD-3334 Duplicate user-defined functions appear in Functions list

MOD-3342 Export fails when appending to an existing Access file and table

MOD-3346 Incorrect labels on the Offline Deactivation Page

MOD-3365 Support for ISO 19770-2 SWID tags

MOD-3366 Monarch should open data from pinned tables in DPS workspaces without testing the source connection.

MOD-3367 Strongly Linked Functions Fail To Load If External Model Is Read-Only

MOD-3369 Ability to override the value of the TEMP and TMP environment variables with the value in the Workpath registry setting

MOD-3374 Add a download to CSV function to the Table Design Field List

ENHANCEMENT Report Chunking - the ability to process very large reports in smaller chunks.

ENHANCEMENT Ability to download the contents of the Field List to CSV

ENHANCEMENT Ability to override the value of the TEMP and TMP environment variables with the value in the Workpath registry setting
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Datawatch Monarch Release Notes           Version 15.2.0
October 1, 2018

ISSUE ID RESOLVED ISSUE
DATA PREP STUDIO (MONARCH COMPLETE ONLY)

DPS-1554 Failed to load image error appearing in log file

DPS-1831 Poor performance when populating filter values

DPS-1880 Filtering Data by Range - data doesn't refresh automatically when using the Advanced Options without 'editing' the range value first

DPS-1882 Range filter type is not working as expected

DPS-1901 Maintain argument default compatibility with Monarch Classic for the STR function

DPS-1963 Syntax error encountered when searching for a non-existent table name

DPS-2136 Incorrect Amount of Columns Defined If CSV Data Structure Significantly Changes Beyond 1000 Rows

DPS-2854 Some records are not visible after refreshing table

DPS-2915 Unexpected data format after Remove Decimals operation

DPS-3317 Missing vertical scroll bar in Excel Options dialog box

DPS-3362 Disable column suffix checkbox should be disabled if multiple aggregation types are selected

DPS-3444 Export list order should reflect the sort order in Prep Data

DPS-3864 Incorrect number of decimal places may be shown when extracting data drom PDF files

DPS-3877 Report Verify does not perform "adjust all fields" consistently with Monarch Classic for floating traps

DPS-3928 Report Design leaves residual temporary files when converting a PDF.

DPS-4051 Using the arrow while in the mask editor should force everything to scroll when reaching the horizontal limit

DPS-4199 Summary-related dropdowns appear in Export Table as CSV (Named Export)

DPS-4206 Temp file created when opening Report Design (*.index.dat) is not deleted

DPS-4224 Google Big Query is displayed instead of "Google BigQuery"

DPS-4244 The query value is not saved in the Connection dialog from Load Options > Edit Table Info
DPS-4249 Segment Temp Files generated but not getting deleted when doing Join
DPS-4262 IBM Cloudant Connection dialog's size is not fixed
DPS-4269 Ok button does not disable in Splunk when editing connection
DPS-4276 Renaming columns whilst on the Analyze tab does not re-calculate which Summaries can be applied to the selected table
DPS-4288 Support for Sharepoint Online in Open Data
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Datawatch Monarch Release Notes           Version 15.2.0
October 1, 2018

ISSUE ID RESOLVED ISSUE
DPS-4289 Export fails when appending to an existing Access file and table
DPS-4292 Error encountered when selected table has no rows.
DPS-4299 Workspace crashes when trying to edit a report in Report Design
DPS-4301 Default state of blank workspace parameter preventing user from clicking OK after selecting an application runtime parameter
DPS-4302 Error encountered when selecting a specific table using DB2 connector
DPS-4303 Duplicate message in error message window for Vertica
DPS-4308 Crash when trying to load data from Public Library
DPS-4325 Crash after entering an incorrect password (5x) for a password-protected data source
DPS-4336 Export may hang on sequential retries
DPS-4345 Crash encountered when selecting a destination folder that has a problem with a Swarm connection
DPS-4348 Report Verify displays an error but the corresponding field is not highlighted.
DPS-4363 Trapping controls getting out of horizontal scrolling sync on some wide reports
DPS-4364 Report shows up blank the second time you go into report design
DPS-4365 When loading data in the query tab preview data option, the row limit is not applied.
DPS-4371 Preview Data and OK buttons are greyed out when loading Object Tables from a Salesforce data source containing high number of fields
DPS-4385 Looping validation alert when editing a Google Analytics connection with an error
DPS-4389 Missing Alt key for File >> Open Data menu option
DPS-4420 OAuth windows prompt excessively
DPS-4423 Using Alt shortcuts to access the application menu keeps it open unnecessarily after selection is made
DPS-4424 On workspace open, DPS asks for PDF password on missing file which would normally not require a password
DPS-4431 Ctrl+mouse wheel should zoom the report viewer in Report Design
DPS-4432 Clearing templates not functioning in the same way as Monarch Classic
DPS-4439 Export tree is displayed incorrectly when prep data tree has sort applied.
DPS-4440 Regex character insertion performance degrades as it grows in length
DPS-4441 Making a filter on a runtime parameter column causes the Prepare grid to go blank and causes futher errors
DPS-4442 Blank report view presented when dragging certain PRN files into the product
DPS-4447 Crash on click to append when source tables have invalid file paths
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Datawatch Monarch Release Notes           Version 15.2.0
October 1, 2018

ISSUE ID RESOLVED ISSUE
DPS-4449 Filter does not rebuild automatically when a runtime parameter value upon which the filter depends is changed
DPS-4474 Crash when typing value in template width that is greater than report width
DPS-4487 Crash when loading an XML file in a French environment
DPS-4491 Crash may occur on a second Merge Column operation

NEW FEATURE Amazon EMR Hive, Google Sheets, Google Drive and SugarCRM Connectors added
NEW FEATURE Easily jump to the change which created the selected column

ENHANCEMENT Option to Create a "New Workspace" From the Menu Dropdown
ENHANCEMENT Show field type on field list items on calculated field expression editor
ENHANCEMENT SAS Transport open filter should support both .xpt and .stx extensions
ENHANCEMENT If you have two tables selected give a context menu option to auto-stage and open the join dialog
ENHANCEMENT Save to Swarm Improvements
ENHANCEMENT Allow more width to runtime parameters dialog on workspace open
ENHANCEMENT Application or Workspace Runtime Parameter sections are now hidden on open workspace if there are no relevant items
ENHANCEMENT Filter Redesign
ENHANCEMENT Show all available timezones
ENHANCEMENT Ability to create a new library file
ENHANCEMENT Change "Remove Column" to "Delete Column" and add "Delete Columns" to the main drop down for multi-select deletion
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Datawatch Monarch Release Notes           Version 15.1.0
July 9th, 2018

ISSUE ID RESOLVED ISSUE
MONARCH CLASSIC (MONARCH CLASSIC & MONARCH COMPLETE)

MOD-2941 Legacy PDF engine not always used when opening very old models

MOD-3256 Incorrect placement of page breaks for summary Excel exports

MOD-3285 Excel Export Error - The Excel file is incompatible with this version of Monarch.

MOD-3300 Trial license expires after 15 days even when the the trial period is 30 days

MOD-3304 Silent Uninstall with Deactivation not releasing the license

MOD-3314 Object reference not set... error when going into Report Design

MOD-3323 Function Unix_Time_Number_To_Date is working incorrectly in UserDefinedFunctions.dmod

MOD-3288 Slow clipboard copy performance when pasting over 100,000 rows

ENHANCEMENT Show Template Name In Task Progress Window

ENHANCEMENT Disable the "Clearing Template" ribbon button when the selected template is a Detail

ENHANCEMENT Monarch Utility - Save to Swarm folder browse dialog using simplified version

ENHANCEMENT Clicking export links open the folder containing the exported file

DATA PREP STUDIO (MONARCH COMPLETE ONLY)

DPS-3309 Expression box could be resized to zero

DPS-3741 Positioning Discrepencies When Loading A PDF-based Model developed using Monarch Classic

DPS-3767 Default date format of the current workspace is not applied when creating a statistics table

DPS-3817 Google AdWords: Rows with empty columns do not display

DPS-3891 Entering Document Options and re-entering Report Design temporarily disables show all template hits
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Datawatch Monarch Release Notes           Version 15.1.0
July 9th, 2018

ISSUE ID RESOLVED ISSUE
DPS-3892 Duplicate columns are created when using Autodefine

DPS-3894 Pivot dialog is missing 'Sort pivot columns' and 'Disable column suffix' checkboxes

DPS-3897 Mouse wheel stops scrolling the report after performing Report Verify

DPS-3901 Failure to import certain database column types

DPS-3927 Sort creates temporary files which are not deleted

DPS-3933 Using the Import button in Lookup Fields results in an orphaned temporary file

DPS-3934 Duplicates Transform creates an orphaned temporary file

DPS-3935 Crash when drag and dropping multiple change list items from one instance into another.

DPS-3936 The Excel file is incompatible with this version of Monarch Error when exporting to a file created with certain new Excel 2016 features

DPS-3953 Issues with Percentage formats when exporting to Excel

DPS-3959 Repeated auto-define leads to no traps being created

DPS-3967 Mouse wheel stops scrolling in report view after making changes in Report Verify

DPS-3981 CSV export alignment issues

DPS-3983 Alignment issues in Edit Fields panel

DPS-3990 Multiple Model nodes cause issues when uploading to Swarm

DPS-3991 Excel Export Error - The Excel file is incompatible with this version of Monarch.

DPS-4024 Horizontal scrolling of the template editor can become out of sync with the report viewer

DPS-4025 Horizontal scrolling of the template editor can become out of sync with the report viewer when using the arrow keys

DPS-4041 Crash when launching the application when using a proxy server for license authentication with invalid credentials

DPS-4050 Rectangle Selection issues in Report Viewer

DPS-4119 Un-named export doesn't open Windows Explorer

DPS-4120 Include Column Header in the Delimited Text Export window not saved to the workspace

DPS-4127 Metadata columns for Excel data sources are not saved when saving to Swarm

DPS-4166 Named export issues when making copies of workspaces

DPS-4228 Rename column behavior is inconsistent
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Datawatch Monarch Release Notes           Version 15.1.0
July 9th, 2018

ISSUE ID RESOLVED ISSUE
DPS-4240 Clearing template incorrectly applied to all templates

DPS-3900 Hitmap recalculation was causing performance issues when creating templates

DPS-1969 Fields in Append Helper UI do not accommodate medium length field names

DPS-3916 Unresponsive UI whilst converting large PDF reports

DPS-4241 Clearing Template ribbon button should be disabled when the selected template is a Detail

DPS-3915 Cursor inappropriately positioned when creating a new Lookup Field

DPS-3916 Unresponsive UI whilst converting large PDF reports

NEW FEATURE Google BigQuery, Cassandra and Hubspot Connectors added

NEW FEATURE Summaries 

ENHANCEMENT Harmonized Input Encodings with Monarch Classic

ENHANCEMENT Open data redesign

ENHANCEMENT Report pages now visible before the entire report has finished loading

ENHANCEMENT Unresponsive UI whilst converting large PDF reports

ENHANCEMENT F1 invokes online help

ENHANCEMENT File/Application menu moved to the left side of the ribbon

ENHANCEMENT When pressing OK in Report Design, the Prep window is opened

ENHANCEMENT Clicking export location link in ad hoc export complete dialog opens folder rather than copying path
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Datawatch Monarch Release Notes           Version 15.0.0
April 30th, 2018

ISSUE ID RESOLVED ISSUE
MONARCH CLASSIC (MONARCH CLASSIC & MONARCH COMPLETE)

MOD-2872 Str function defaults cause blank output if a numeric value is greater than 10 digits

MOD-3069 Doubleclick Not Adding Columns In Summary Add/Remove Field Dialog

MOD-3098 Copy/paste into Excel Sheet of Monarch column with "Thousands" formatting not working as expected

MOD-3100 Total Pages shows unexpected output

MOD-3105 CMD Line triggers a return keystroke in any active application

MOD-3126 Long delay when loading complex Model with a large amount of interdependencies

MOD-3128 Long delays whilst typing regular expressions

MOD-3132 PDF file displays boxes when containing certain characters

MOD-3152 Existing Conditional Formatting In XLSX Files May Be Removed When Adding Data to File Via Export

MOD-3153 PDF File unable to load if XREF table is invalid

MOD-3155 Error when attempting to perform a Split by Key value Summary export using SAS Transport (xpt) format

MOD-3161 Import Filter not working for SAS Transport (xpt) input files

MOD-3172 Floating trap created in an earlier version not properly aligned

MOD-3188 Crash when quitting Report Design using Binary Input As A Report

MOD-3205 Monarch command lines do not preserve the casing of input arguments

MOD-3239 License Server credentials are not saved in registry on Monarch first launch

MOD-3254 Lines which contain the hyphen character (0x2010) display improperly when using some fonts

ENHANCEMENT Ability to upload Models to Monarch Swarm with Monarch Utility

ENHANCEMENT Go To Column function in context menu

ENHANCEMENT Base64Decode and Base64Encode functions
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Datawatch Monarch Release Notes           Version 15.0.0
April 30th, 2018

ISSUE ID RESOLVED ISSUE

DATA PREP STUDIO (MONARCH COMPLETE ONLY)

DPS-1064 A new path is not created during an export to Angoss
DPS-2262 Unable to get leading zeros to show in data originated in a PDF
DPS-2574 Duplicated columns may be produced by overlapping fields for text and PDF report inputs
DPS-2729 Incorrect rounding of numeric columnms when using auto-define on text and PDF report inputs
DPS-2730 Changing a Numeric column to a Character from a text or PDF Report input produces blanks
DPS-2754 Calculated Field Names are not automatically trimmed for whitespace on creation
DPS-2844 Input string was not in correct format error using MongoDB on a client system with a decimal seperator other than a period
DPS-3071 Inconsistency in loading numeric data from a Monarch project to DPS
DPS-3078 Unclear export result error in Export Data Tab when exporting to Tableau Server without supplying sufficient configuration details
DPS-3080 Unclear export result error in Export Data Tab when exporting to an open Excel file
DPS-3121 Inconsistency in data when opening a Project using Excel input containing Date/Time values
DPS-3157 Google Analytics connector dialog is initially displayed in the incorrect screen position
DPS-3181 Exporting to Swarm with a user assigned to the Consumer role produces a misleading error message
DPS-3184 Inconsistency in data when opening a Project or Model with an input of purely time values
DPS-3194 Custom change view can be maximized, but not restored.
DPS-3202 Error in log when exiting
DPS-3236 The table name loaded is different from the selected Salesforce Objects Table in Salesforce Connection dialog box
DPS-3299 The Library becomes hidden if the product icon in the taskbar is pressed whilst the Library is already open
DPS-3315 Spurious lines of text containing the word "Test" appear in log files.
DPS-3396 Watson, Tableau Tde, Cognos, and Qlik exports are failing to preserve their Overwrite state on Workspace load
DPS-3410 Escape does not cancel the append helper dialog
DPS-3416 Crash when dragging an Excel file over one of the join drop zones.
DPS-3436 Filter which is on top of an append is forced to re-evaluate every time you click away from the table and click back.
DPS-3439 'Save Credentials' option on License Credentials dialog contradicts with LS server setting
DPS-3450 Export Data label is showing * even when no exports have been added
DPS-3459 Ctrl+mwheel is not working in the formula editor of the calculated fields dialog
DPS-3476 Crash right-clicking the Close button of the Select a Transform Type Window

NEW FEATURE Google Adwords, Netsuite, Sharepoint and Vertica Connectors added
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ISSUE ID RESOLVED ISSUE
NEW FEATURE JSON Export
NEW FEATURE Object Descriptions
NEW FEATURE Column View Filtering
NEW FEATURE Runtime Parameters
NEW FEATURE Lookup Calculated Fields

ENHANCEMENT Full Report Design functionality introduced to replace Report Discovery
ENHANCEMENT Enhanced Table Append functionality
ENHANCEMENT Enhanced Monarch Swarm Workspace upload
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